S.1.

BABS
HASIL DAN PEMBAHASAN

Data Lapangan
Proyek yang ditinjau dalam penelitian ini adalah Proyek Pembangunan
Gedung Laboratorium Enterpreneurship Terpadu Tahap I Universitas Brawijaya,

dengan :

Nilai Kontrak : Rp.24.050.124.000,-
Waktu Pelaksanaan : 150 Hari Kalender
Tanggal Pekerjaan dimulai : 25 Juli 2013
Tanggal Pekerjaan selesai : 21 Desember 2013

Pada penelitian ini, hanya dijabarkan secara terperinci tentang pekerjaan
struktur proyek. Proyek ini terdapat 10 lantai yang akan dikerjakan, akan tetapi
untuk penilitian ini dipotong menjadi 7 lantai. Sehingga pekerjaan mobilisasi dan
pekerjaan pengembalian kondisi dan pekerjaan minor tidak didimasukan, déngan
rincian sebagai berikut:

Nilai kontrak struktur 10 lantai : Rp. 16,878,252,073.28

Nilai kontrak Struktur 7 lantai  : Rp. 11,927,341,084.74

Waktu pelaksanaan : 95 hari kalender

Mhemmrrnl sneelal ot a1 ~ 4 . ~ o~
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PERINCIAN PEKERJAAN
(BILL OF QUANTITY)
PEKERIAMN. : PEMBANGUNAN GEDUNG LABORATORIUM ENTERPRENEURSHIP TERPADU
UNIVERSITAS BRAWAYA TAHAP I
LOKAS! + UNIVERSITAS BRAWVAYA JL VETERAN, MALANG LINGKUP PEKERJAAN : STRUKTUR
K ITEWPERERUAAN. o) G,
|IREKAPITULASI
A PEKERJAAN STRUKTUR
[l | BANGUNAN GEDUNG LABORATORIUK! SOSIO ENTERPRENELRSHIP
.2 | PEKERJAAN STRUKTUR BETON
f121.| SUB STRUKTUR 60,484,952.99
I12.2.| UPPER STRUKTUR.
I.22.1,| Lantai Semi Basement (EL - 3.500) 46,72490022
1122.2.] Lanfai Satu{E1.- 50} 2,239.059,152.44
1223 LantsiDua (EL 4 4150) 209955384748
11224 | LantaiTiga (EL + 8.350) 1,883,603,958.12
1225, | LantsiEmpat (EL+ 12550) 1,381,635418.40
01226, LanfaiLima {EL + 16.750) 1,410.115,808.07
(1227, LanaiEnam (EL+ 20850) 1.413,075.490.54
11228, | Lanfai Tujuh (EL+ 25.450) 1,393,027,656.52 11,927 341,084.74
1229, Lantai Delapan (1 + 20.350) 1402.766,694.14
112210, | Lantai Sembian {1 +33.600) 1,364,219517.16
12211, LantaSepuuh (L +37.750) 1.322463,00871
13212 LanfsiRL1 {EL + ) 46,647,336.18
112213.) LantaiRL2 (EL+ ) 51471434335 4,330,310,988.4
TOTAL - [LBANGUNAN GEDUNG LABORATORIUM SOSIO ENTERPRENEURSHIP : 16,878,252,073.2

Note: Highlight wama biry adalah hasil analisa MCO sementara
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5.2. Analisis Data

Pada bab ini pula akan dijabarkan secara terperinci mengenai optimasi
waktu dan biaya proyek dengan metode crash pada Proyek Pembangunan Gedung
Laboratorium Enterpreneurship Terpadu Tahap II Universitas Brawijaya dengan
program Microsoft Project 2007. Analisis data dilakukan dengan menginputkan
data secara langsung ke dalam program Microsoft Project 2007,' yang meliputi
dua tahap yaitu:

1.Menyusun rencana jadwal dan biaya proyek (baseline)
2.Optimalisasi dengan (actual overtime work)

3.2.1 Menyusun Rencana Jadwal dan Biaya Proyek (Baseline)

Langkah-langkah yang dilakukan untuk menyusun rencana jadwal dan:
biaya proyek pada Microsoft Project 2007 sebagai berikut:

1. Membuat lembar kerja baru
Kiik tombol Start > Program > Microsoft Office > Microsoft Office Projeck

-~ 2007,

2. Memasukan tanggal dimulaj proyek

Mengaktifkan menu Projeck > Projeck Information. Pada kotak dialog Projeck
Information dipilih Schedule From : Projeck Start Date dan memasukan
tanggal dimulainya proyek yaitu 25 Juli 2013 pada kotak Start Date. Langkah

. -



- T N
’ Prect eforeation fov WS Projeck U becta T . v e R o e ER 1
Swrtdate:  [Tha7/25/13 v| Cuventdate: [Tue7/29/14 I
} 4 _ July, 2013 '} : .
Finish dte: S5 Mo Tu We Th F &a Status date: INA F‘I
Scheduefrom: | 30 1 2 3 4 5 6 | Csendin  [Stondend -1

] 7 8 91011 12 13
Al 14 15 16 17 18 19 20 | Priovty:
Enterpeie O 21 22 23 24[25 26 27
- 28 2 3031 1 2 3 [

Gambar 5.2. Memasukan Tanggal Dimulainya Proyek

26

3. Memasukan data kegiatan proyek dengan mengetikannya pada kolom Task

Name dan waktu kegiatan pada kolom Durasi. Setelah kolom durasi diisi,

kolom Start dan Finish akan terisi secara otomatis.

4. Memasukan hubungan antara pekerjaan satu dengan yang lainnya pada kolom

Predecessor.

Contoh pengisian:

a. Pekerjaan beton cor K.350 (pada baris 16) dimulai setelah pekerjaan bekisting
(pada baris ke 18) selesai dikerjakan (Finish to Start). Maka, pada kolom
predecessor pekerjaan pekerjaan cor K.350 diisi 18FS.

b. Pekerjaan bekisting tangga (pada baris 30) dapat dilakukan 7 hari setelah
pekerjaan cor beton K.350 (pada baris 41). Maka, pada kolom predecessor

pekerjaan bekisting tangga diisi 41FS+7days. Hasil langkah 3 dan 4 dapat

5 1.4 J-3 MUSOORIIpERE IR . DEDUIE FSIREY e DS ).} FpEpEn 1
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Gambar 5.3.Penyusunan Pekerjaan (Zask)

5. Menyusun kalender kerja untuk menentukan hari kerja dan jam Kkerja.
Pada proyek ini hari kerja dalam seminggu adalah 7 hari. Sedangkan pada
Microsofi Project 2007 secara default adalah 5 hari kerja dalam semnggu.

Untuk mengubah maka dilakukan dengan cara :

a. Memilih menu Tools > Change Working Time.

b. Klik tab Work Weeks > Details

c. Pada select day(s), pilih Sunday > set d.ay(s) to these specific working
times.

d. Mengisi From: 08.00 To 12.00 dan From: 13.00 To 17.00.

a T Tentnrls lhnwi ol manlra Ailalbvilram smanaahnhan srano cnmoe canmarts haes
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‘_ Details for '[Defauit)” _—

1 4

- L B

Set working time for this work week - - --

O Use Project default times for these days.

Select day(s):

0 Set days to ponwoerking time.

] [

19 Set day(s) to these spedific working times:

Cence!

01<1[
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Gambar 5.4. Menyusun Kalender Kerja

6. Menyimpan rencana jadwal dan biaya sebagai baseline.

e T TR e it e |8

Klik menu Tools > Tracking > Set baseline, sehingga kolom baseline yang

semula nol akan terisi sebagai target biaya yang nilainya sama dengan Total

Cost.
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5.2.2 Optimalisasi Dengan (Actual Overtime Work)
Optimalisasi  dilakukan dengan mengisikan data yang telah
dioptimmalkan untuk dibandingkan dengan rencana. Langkah-langkah pada

tahap ini meliputi:

1. Membagi layar Micrososoft Project menjadi dua (atas dan bawah) untuk
memasukan data crash perencanaan. Layanan atas berupa Gantt Chart
View dua layar bawah dengan Task Usage, lalu klik View > Table : Cost.

2. Menambahkan baris pada bagian kanan Task Usage dengan menekan
mause kanan, pilih Detail Styles. Masukkan Actual Work (Show), Actual
Overtime Work (Show), Actual Cost (Show), OK

I, B P 5t 8 o 7 : AT N o]0 mr]
Elpn 18 Yo beet tenes luwmmhm — B e e .u‘?""“"’"'f'_""’__.‘"_.;i
TELE B EETE RS XTI NS CC R KR SR Wl 7 T -~ R

'3 in 8 % Membtassatens A O Tel T N,
T e e A

0
Mk T i T a1 Tecp 7%, 13 ) . .
= [ e O} i W hi W Y T O ] ¥ w L3 ¥ ) k)

Gambar. 5.6. Hasil Task Usage.

3. Melakukan Tracking terlebih dahulu sebelum memasukan jam lembur

pada baris Actual Overtime Work yaitu dengan cara Klik Task > Task

Toufrwnmintinam - fNannea 1~ Damnand namnlata FAION0LY 5 Mumatinn {cacnal
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Gambar, 5.7. Langkah Tracking.

4. Memasukkan jam lembur resources work pada baris baris actual overtime

work.

Cara pengisian :

Pekerjaan (Bekisting kolom lantai 1) task 22 dalam perhitungan dapat
diselesikan dengan 40 jam yang berarti pekerjaan dikerjakan dalam 5 hari
dengan prediksi lembur 1 sampai 4 jam. Durasi 5 hari telah dimasukkan dalam
Duration pada langkah 5. Langkah 6 hanya memasukkakn jam lembur sesuai
hasil pada percobaan jam lembur. Actual Overtime Work dengan menuliskan
4.49 hari untuk jam lembur 1 jam, 4.12 hari untuk lembur 2 jam, 3.85 hari
untuk lembur 3 jam dan 3.64 hari untuk lembur 4 jam. Kemudian secara

otomatis microsoft project akan menghitung dalam benntuk days.
Pekerjaan Bekisting Kolom Lantai 1 (Untuk lembur 1 jam):

Data

T .- 1. __*_n___* Fa s A Y — D t___n__°*
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- Durasi /hari (Cd) =5 hari

- Volume (V) =1,014.11 m’

- Produktifitas Normal (Fn)= CI':I =104l 202.82 m*/hari
- Produktifitas/jam (F) = }\}; = 202.8 =25.35 m*/jam
Crashing pada 1 jam pertama.

- Jam kerja/jam (Ndc) =8+1 = 9 jam/hari

Produktifitas/jam = 25.35 m%jam (Jam kerja normal)

Koefesien pengurangan produktivitas pada I jam lembur (0.9)

Produktifitas Crash (Fc) =25.35* 0.9 =22.82 m*jam

Produktifitas Normal (Fn)= (F*(Ndc-jam lembur)+Fc*jam lembur)
= (25.35%(9-1)+22.82*1)

= 225.62 m*/hari

_ 1014.11

¥ = 4.49 hari
Fn 225.62

Durasi (Dc) =

Jam lembur hanya untuk resources work (pekerja, tukang, kepala tukang, dan

mandor).

Langkah memasukkan jam lembur pada Microsoft Project :

Menampilkan layar seperti langkah nomer. 2 diatas.

Kolom Actual Work diisi jumlah resources sesuai hitungan :

Jumlah pekerja normal

Pekerja =901.41 orang
Kepala tukang = 10.06 orang
Tukang kayu = 100.55 orang

Mandor = [.83 orang

. . 4 o A T [
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Total jam lembur =Nd*Dc =(8%0.51) =4.04jam
Pekerja =901.41%4.04 =369.76 orang

Kepala tukang =10.06 *4.04 =40.67 orang

Tukang kayu =100.55 *4.04=406.73 orang

Mandor =1.83 *4.04 =7.40 orang

32

(berlaku untuk resources work lain dan secara otomatis Microsoft Project

akan menghitung dalam bentuk days).

- Kolom Actual Cost terisi jumlah biaya yang otomatis terhitung jika kolom
Actual Work dan Actual Overtime telah terisi.
- Kolom Work terisi jumlah dari Actual Work dan Actual Overtime.
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Gambar. 5.8. Input Durasi Lembur pada Micosoft Project.

Tabel. 5.1. Baseline

. . Biaya Durasi
NO Uraian Pekerjaan (Rupiah) (Hari)
A. Pekerjaan Struktur
IL Bangunan Gedung Laboratorium Sosio Enterprencurship
I1.2. Pekerjaan Struktur Beton

1721

Qb Striiketir




Shear Wail SW 60,414,274.20 | 10 Days
Upper Struktur.
Tangga Beton T=15 Cm 46,621,639.80 | 7 Days
Lantai Satu ( El. - 50) .
Plat Lantai 656,539,606.80 | 8 Days
* Pek.Kolom 895,165,507.20 | 6 Days
Balok 637,030,133.20 | 8 Days
Tangga Beton 50,212,683.00 | 8 Days
Lantai Dua (El +4.150)
Plat Lantai - 568,337,494.00 | 8 Days
Pek.Kolom 820,267,932.00 | 6 Days
Balok 660,513,606.00 | 8 Days
Tangga Beton 49,346,358.00 | 7 Days
Lantai Tiga ( EL +8.350)
Plat Lantai 674,596,617.20 | 8 Days
Pek.Kolom 510,780,819.60 | 6 Days
Balok 648,130,365.40 | 8 Days
Tangga Beton 49,350,673.20 [ 7 Days
Lantai Empat ( EL +12.550)
Plat Lantai 400,781,450.20 | 8 Days
Pek.Kolom 509,479,471.60 | 6 Days
Balok 423,257,013.00 | 8 Days
Tangga Beton 48,260,068.20 [ 7 Days
Lantai Lima ( El. +16.750)
Plat Lantai 399,542,839.20 [ 8 Days
Pek.Kolom 511,052,967.40 | 6 Days
- Balok 450,762,743.20 | 8 Days
Tangga Beton 48,701,928.20 [ 7 Days
Lantai Enam ( EL + 20.950)
Plat Lantai 400,631,812.40 | 8 Days
Pek.Kolom 509,088,980.80 | 6 Days
Balok 454,401,325.80 | 8 Days
Tangga Beton 48,901,908.20 | 7 Days
Lantai Tujuh ( EL +25.150)
Plat Lantai 400,331,899.00 | 8 Days
Pek.Kolom 507,669,601.48 | 6 Days
Balok 436,805,541.20 | 8 Days
Tangga Beton 48,901,908.20 [ 7 Days
Total 11,925,879,167.68

.Q\“lrn‘hpr - uﬂﬂ;1 Trarlifiremecrars AL smmcmdd Dundn s 301 A
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5.3 Pembahasan

3.3.1. Percepatan Proyek (Crash Program)

Percepaian dapat dilakukan dengan berbagai cara, antara lain : menambah sumber
daya berkualitas. Penambahan waktu jam kerja (lembur), mengatur kembali jadwal
yang terlambat maupun saling tukar tenaga kerja yang memiliki keahlian yang sama.
Namun, pada penelitian ini hanya akan dilakukan percepatan dengan metode
penambahan jam ketja (lembur) dan penambahan sumber daya. Dalam metode inipun
harus diperhatikan beberapa hal antara lain -

a. Kondisi ruang gerak di tempat kerja yang mengharuskan menggunakan
sejumlah pekerja tertentu.
b. Penggunaan pekerja yang lebih banyak akan menurunkan productifitas
kelompok kerja iersebut.
Berdasarkan bagan balok (gantt chart) pada Microsoft Project dapat dilihat lintasan
kritis. Pada penilitian ini yang dipercepat hanya proyek bagian struktur dan diambil 7
lantai dari 10 lantai serta dilakukan crah sebanyak 4 kali hingga lintasan kritis telah
jenuh. '

5.3.2. Tahap-Tahap Percepatan
Berikut ini akan diuraikan tahap-tahap percepatan pada jadwal rencana proyek
5.3.2.1. Kondisi Normal

Pada kondisi normal waktu pelaksanaan proyek adalah 95 hari kalender dan
terdapat beberapa jalur krtis yang terlihat dalam gantt chart microsoft project.

PDunrnnwumbmna e a1 0 1 4 . W e e - - -
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Gambar. 5.9 Biaya Tidak Langsung Kontraktor Besar (Biemo W.S. 2010)

Dari Gambar. 5.9. biaya tidak langsung dengan nilai proyek berkisar 24 milyar
maka biaya tidak langsung sebesar 6.75 % yang di-indent dalam biaya
langsung awal proyek dapat diketahui yaitu,

Biaya Langsung= Biaya total —( %x Biaya Total)

=Rp. 11,925,879,167.68 — ( 9—7(—;5-11 Rp.11,925,879,167.68)

=Rp. 11,120,882,323.86
. . _6.75
Biaya Tidak Langsung = —IW x Biaya Total

= 875, Rp. 11,925,879,167.68
100

= Rp. 804,996,843.82

__ BiayaTidakLangsung

Dinxtrs T dalr T A ovarten mofla mope
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= Rp. 8,473,650.99

_ Rp.11,925,879.167.68
95hari

Biaya Total/hari

= Rp. 125,535,570.19

Contoh perhitungan pekerjaan akibat crashing pada penambahan Jjam kerja.
1) Pekerjaan Bekisting Kolom Lantai | (Task 22)

Nd =5 hari

Volume =1,014.11 m*

SDM =

- Pekerja (P)) =369.76 - 91.41 =278.35 orang
- Kepala tukang (T}) =40.67 - 10.06 = 30.61 orang

- Tukang kayu (K.T)) =406.73 - 100.55 = 306.18 orang
- Mandor (M) =740-1.83 =5.57 orang
Biaya lembur Pekerjaan Bekisting Kolom Lantai 1 (data sesuai proyek)
- Pekerja (P,) =Rp. 5.500/jam
- Kepala tukang (T,) =Rp. 8.250/jam
- Tukang kayu (K.T,) =Rp. 6.875/jam
- Mandor (M;) = Rp. 9625/jam
Biaya total lembur
- Pekerja =278.35 *5500/jam = Rp. 1.530.925,00

- Kepala tukang =30.61 * 8250/jam =Rp. 252.532,50

[



- Mandor =5.57*9625/jam _=Rp. 53.611.25
Total biaya lembur =Rp. 3,942,056.25
Produktifitas Normal (Fn) = CI'; = 101:'11 = 202.82 m?*hari
Produktifitas (F) =2 208 s 35 mam
Nd 8
Produktifitas Crash (Fc)  =25.35% 0.9 = 22.82 m*/jam

Produktifitas Normal (Fn) = (F*(Ndc-jam lembur)+Fc*jam Iembur)

= (25.35%(9-1)+22.82*1)

=225.62 m*/hari
Durasi/hari (Dc) - }% ~ 1202154‘6121 = 4.49 hari

37

(Berarti peketjaan bisa diselesaikan dalam waktu 4.49 hari dengan lembur 1

jam)

Harga Nonmaterial crash

=Cd*P1*n.pekerja)HCd*K.T1 *n.K.thg}+(Cd*T1*n.tkg)(Cd*M *n.mndr)+

Total lembur.

=(5%18.28*Rn.44.000.00-/5%7 0117%Rn RR NNN NNVLISEAA 11%1— CC ARA AAL .



- Paku Segala ukuran ( Rata - Rata )

=310.8 kg *Rp. 20,000.00 =Rp. 6.216.000.00

- Balok 8/15 & 6/15 ( Kayu borneo )

= 11.65 m**Rp. 6,000,000.00 =Rp. 69.930.000.00

- Plywood t. 9 mm

=271.95 Ibr* Rp. 145,000.00 =Rp. 39.424.750.00

- Dolken kayu dia. 8 - 400 cm

= 555.98* Rp. 24,500.00 =Rp. 13.621.510.00

- Multiplek fenol film 18 mm

=269.77 m’ * Rp. 329,600.00 =Rp. 88.917.642.24

Total
2 kali pakai

Harga Total Crash

Slope

=Rp. 218.117.902.2
=Rp. 109.058.951.1
= Harga Nonmaterial Crask + harga material
=Rp. 14.296.466.25 + Rp. 109.058.951.1
=Rp. 123.355.4174

= (Harga Nonmaterial Crash — Harga Nonmaterial)
(Nd-Cd)

_ Rp.14.296.466.25 - Rp.10.354.410.00
5-4.49

— Mae T AN CHAN ADN AN
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Tabel 5.2 Perbedaan Biaya Berdasarkan kontraktor dengan Microsoft Project.

No Itemn Pekerjaan Kontraktor Ms Projeck Selisih
(Rupiah) (Rupiah) (Rupiah)

1. Sub Struktur 60,484,952.99 60,414,274,20 70,678.79
2. Lantai Semi Basement 46,724,900.22 46,621,639.80 | 103,260.42
3. | Lantai Satu ( EL - 50) 2,239,059,152.44 | 2,238,947,930.20 111,222.24
4, Lantai Dua (EL +4.150) 2,099,553,847.48 | 2,098,465,390.00 | 1,088,457.48
5. | Lantai Tiga (EL + 8.350) 1,883,663,958.12 | 1,882,858.475.40 805,482.72
-1:6. Lantai Empat ( EL +12.550) | 1,381,635,418.40 1,381,778,003.00 | -142,584.60
7. Lantai Lima (EL +16.750) | 1,410,115,808.02 1,410,060,478.00 55,330.02
‘8. | Lantai Enam ( EL +20.950 ) | 1,413,075,490.54 | 1,413,024,027.20 51,463.34
9. Lantai Tujuh (EL +25.150) | 1,393,027,556.52 1,393,708,949.88 | -681,393.37
Total 11,925.879.167.68 | 1.461.017 03
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Crashing 3 Jam Crashing 4 Jam

Waktu Pelaks?/ Days

B. Pekerjaan Strj.

I Bangunan Ge

1.2, Pekerjaan Str,! —
12.1. | " Sub Strukgar 127420

60,414,274.20 60,414,274.20

46,621,639.80 46,621,639.80

1122 | Upper Struke

22,1, Lantai Semi j039-80

222, Lantai Sate (5,194.80 2,275,312,066.80 2,251,046,536.50

4
IM2.2.3. | Lantai Dua 299730

2,107,669,877.60 2,108,957,479.30

{
I12.2.4. | Lantai Tiga t’458'00

1,907,402,911.80 1,915,749,424.70

1 852.80

I12.2.5. | Lantai Empa? 1,384,552,434.00 1,394,889,905.10

I
—,792.60
[1.2.2.6. | Lantai Lima:

1,416,781,603.40 1,426,736,539.60

,510.40

1,420,723,734.60 " 1,427,702,327 .10

I12.2.7.| Lantai Enam’

——569.98
[12.2.8. | Lantai Tujuh .

1,394,511,399.88 - 1,403,905,182.08

I /889.88

12,013,989,942.08 12,036,023,308.38

T0|tal

88,110,774.40 110,144,140.70

SeWisih

Prosentase Perubahan | Jumlah Pekerjaan Yang
Jam Durasi;!' Biaya | Dilemburkan
Lembur | _ (%) (Pekerjaan)
(fam) [
Ngrmal 0.998 21
: : 0.995 21
2 | 0.993 21
3 ?I 0.991 21
4 )

Sumber :Hasil Rekapit,
"
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5.3.2.2, Kompresi dengan Penambahan Lembur 1 jam
Kompresi yang dimaksud adalah tahap percepatan dengan melakukan
usaha pemendekan waktu pada pekerjaan yang dihasilkan tahap sebelumnya, yaitu

tahap normal,
Perhitungan kebutuhan percepatan pada kondisi normal yang diinput pada
N,Iicrosoﬂ Project menyebabkan timbulnya lintasan kritis baru dengan
pengurangan waktu pelaksanaan proyek dari 95 hari kerja menjadi 93.58 hari
crja. Percepatan pada tahap ini menyebabkan kebutuhan biaya proyek
engalami kenaikan hingga mencapai Rp. 29,627,115.10 dari biaya semula Rp.
1,925,879,167.68 menjadi Rp. 11,955,506,282.78. Uraian pekerjaan pada-tahap

ini dapat dilihat pada Tabel 5.3. Lintasan kritis itu antara lain task 8, 26, 18, 22,
3,35, 39, 60, 52, 56, 77, 69, 73, 94, 86, 90, 111, 103, 107, 128, 115, 132.

Tabel 5.5 Penambahan jam kerja lembur 1 jam

_ Durasi
No 'II‘\Ia:k Uraian Pekerjaan Normal | Crash 1 Jam
(Hari) (Hari)

RE Bekisting Shear wall 5 9
2 |26 | Bekisting balok lantai 1 7 6.29
3 18 Bekisting plat lantai 1 7 6.29
4 22 Bekisting kolom lantai 1 5 4.49
5 43 Bekisting balok lantai 2 7 6.29
6 35 Bekisting plat lantai 2 7 6.29
7 39 Bekisting kolom lantai 2 5 4.49
8 60 Bekisting balok lantai 3 7 6.29
9 52 Bekisting plat lantai 3 7 6.29
10 56 Bekisting kolom lantai 3 5 4.49
11 77 Bekisting balok lantai 4 7 6.29
12 Te9 Bekisting plat lantai 4 7 6.29
13 73 Bekisting kolom lantai 4 5 4.49
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14 04 Bekisting balok lantai 5 7 6.29
15 86 Bekisting plat lantai 5 7 6.29
16 90 Bekisting kolom lantai 5 5 449
17 111 Bekisting balok lantai 6 7 6.29
18 103 Bekisting plat lantai 6 7 6.29
19 107 Bekisting kolom lantai 6 5 4,49
20 |128 | Bekisting balok lantai 7 7 6.29
21 115 Bekisting tangga beton lantai 6 6 6

22 132 Bekisting tangga benton lantai 7 6 6

Sumber : Hasil Perhitungan Microsoft Project 2014.
5.3.2.3. Kompresi dengan Penambahan Lembur 2 jam
Kompresi pada tahap ini dilakukan terdapat kondisi normal, dan
didapatkan hasil waktu penyelesaian proyek yaitu 92.77 hari dengan total biaya
yang diperlukan sebesar Rp. 11,980,664,889.88 yang berarti mengalami
pertambahan sebesar Rp. 54,785,722.20 dari biaya rencana semula. Sedangkan
unfuk lintasan kritis baru pada tahap ini dapat dilihat pada Tabel 5.4. Lintasan
kritis itu antara lain task 8, 26, 18, 22, 43, 35, 39,'60, 52, 56, 77, 69, 73, 94, 86,
90, 111, 103, 107, 128, 127, 115, 132.

Tabel 5.6 Penambahan jam kerja lembur 2 jam

Durasi
No Ne. Uraian Pekerjaan Normal | Crash 2 Jam
i (Har) | (Her)
1 6 Bekisting Shear wall 9 9
2 26 Bekisting balok lantai 1 7 5.77
3 18 Bekisting plat lantai 1 7 577
4 22 Bekisting kolom lantai 1 5 4.12
5 43 Bekisting balok lantai 2 7 5.77
6 35 Bekisting plat lantai 2 7 5.77
7 39 Bekisting kolom lantai 2 5 4.12

kT8-S
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8 60 Bekisting balok lantai 3 7 5.77
9 52 Bekisting plat lantai 3 7 5.77
10 56 Bekisting kolom lantai 3 5 4,12
11 77 Bekisting balok lantai 4 7 5.77
12 69 Bekisting plat lantai 4 7 5.77
13 73 Bekisting kolom lantai 4 5 4.12
14 94 Bekisting balok lantai 5 7 5.77
15 86 Bekisting plat lantai 5 7 5.77
16 90 Bekisting kolom lantai 5 5 4.12
17 111 Bekisting balok lantai 6 7 5.77
118 103 Bekisting plat lantai 6 7 5.77
19 107 Bekisting kolom lantai 6 5 4.12
20 128 Bekisting balok lantai 7 7 5.77
21 127 Besi balok lantai 7 6 6
22 115 Bekisting tangga beton lantai 6 6 6
23 132 Bekisting tangga benton lantai 7 6 6

Sumber : Hasil Pethitungan Microsoft Project 2014

3.3.2.4. Kompresi dengan Penambahan Lembur 3 jam

Kompresi pada tahap ini dilakukan terdapat kondisi normal, dan

didapatkan hasil waktu penyelesaian proyek yaitu 92.38 hari dengan total biaya
-yang diperlukan sebesar Rp. 12,013,989,942.08 yang berarti mengalami
pertambahan sebesar Rp. 88,110,774.40 dari biaya rencana semula. Sedangkan
untuk lintasan kritis baru pada tahap ini dapat dilihat pada Tabel 5.4. Lintasan

tis itu antara lain task 8, 26, 18, 22, 43, 35, 39, 60, 52, 56, 77, 69, 73, 94, 86,

1T1 1N? 1NA7 1A0 1AM 1mr 447~ c2ma 4n
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Tabel 5.7 Penambahan jam kerja lembur 3 jam
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No. Durasi
No Task Uraian Pekerjaan Normal | Crash 3 Jam
(Hari) (Hari)

1 6 Bekisting Shear wall 9 9
2 26 Bekisting balok lantai 1 7 5.38
3 18 Bekisting plat lantai | 7 5.38
4 22 Bekisting kolom lantai 1 5 3.85
5 43 Bekisting balok lantai 2 7 5.38
6 35 Bekisting plat lantai 2 7 5.38
7 39 Bekisting kolom lantai 2 5 3.85
8 60 Bekisting balok lantai 3 7 5.38
9 52 Bekisting plat lantai 3 7 5.38
10 56 Bekisting kolom lantai 3 5 3.85
11 77 Bekisting balok lantai 4 7 5.38
12 69 Bekisting plat Iantai 4 7 5.38
13 73 Bekisting kolom lantai 4 5 3.85
14 94 Bekisting balok lantai 5 7 5.38
15 86 Bekisting plat lantai 5 7 5.38
16 90 Bekisting kolom lantai 5 5 3.85
17 111 Bekisting balok lantai 6 7 5.38
18 103 Bekisting plat lantai 6 7 5.38
19 107 Bekisting kolom lantai 6 5 3.85
20 128 Bekisting balok lantai 7 7 538
21 127 Besi balok lantai 7 6 6
22 126 Beton balok k-350 lantai 7 1 1
23 115 Bekisting tangga beton lantai 6 6 6
24 113 Beton tangga k-350 latai 6 I 1
25 132 Bekisting tangga benton lantai 7 6 6
26 130 Beton tangga k-350 lantai 7 1 1




5.3.2.5. Kompresi dengan Penambahan Lembur 4 jam
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Kompresi pada tahap ini dilakukan terdapat kondisi normal, dan

didapatkan hasil waktu penyelesaian proyek yaitu 92.09 hari dengan total biaya
yang diperlukan sebesar Rp. 12,036,023,308.38 yang berarti mengalami

perfambahan sebesar Rp. 110,144,140.70 dari biaya rencana semula. Sedangkan
untpk lintasan kritis baru pada tahap ini dapat dilihat pada Tabel 5.4. Lintasan
kritjs itu antara lain task 8, 26, 18, 22, 43, 35, 39, 60, 52, 56, 77, 69, 73, 94, 86,

90,1111, 103, 107, 128, 127, 126,115, 113, 132, 130.

Tabel 5.8 Penambahan jam kerja lembur 4 jam

No. Durasi
No Task Uraian Pekerjaan Normal | Crash 4 Jam
(Hari) (Hari)

1 6 Bekisting Shear wall 9 9
2 26 Bekisting balok lantai 1 7 5.09
3 18 Bekisting plat lantai 1 7 5.09
4 22 Bekisting kolom lantai 1 5 3.64
5 43 Bekisting balok Iantai 2 7 5.09
16 35 Bekisting plat lantai 2 7 5.09
7 39 Bekisting kolom lantai 2 5 3.64
8 60 Bekisting balok lantai 3 7 5.09
9 52 Bekisting plat lantai 3 7 5.09
0 56 Bekisting kolom lantai 3 5 3.64
11 77 Bekisting balok lantai 4 7 5.09
12 69 Bekisting plat lantaij 4 7 5.09
13 73 Bekisting kolom lantai 4 5 3.64
14 94 Bekisting balok lantai 5 7 5.09
15 86 Bekisting plat lantai 5 7 5.09
16 90 Bekisting kolom lantai 5 5 3.64
17 111 Bekisting balok lantai 6 7 5.09
18 103 Bekisting plat lantai 6 7 5.09
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19 107 Bekisting kolom lantai 6 5 3.64
20 128 Bekisting balok lantai 7 7 5.09
21 127 Besi balok lantai 7 6 6
22 126 Beton balok k-350 lantai 7 1 1
23 115 Bekisting tangga beton lantai 6 6 6
24 113 Beton tangga k-350 latai 6 1 1
25 132 Bekisting tangga benton lantai 7 6 6
26 130 Beton tangga k-350 lantai 7 1 1

jumber : Hasil Perhitungan Microsoft Project 2014.
5.3.

Perubahan Biaya Proyek

Dari kempat tahap crash yang telah dilakukan dapat dilihat besarnya

biaya yang harus dikelurkan untuk melakukan kerja lembur maupun penambahan

tenaﬁ.a kerja. Selain itu, dari pengolahan dengan Microsoft Project dengan

meng

inputkan data kebutuhah lembur dan penambahan tenaga kerja berdasarkan

tabulasi percepatn yahap 1 hingga tahap 4 diperoleh perubahan jumlah biaya total

dan penambahan besarnya biaya tidak langsung yang dikeluarkan oleh proyek .
Nominal perubahan biaya dapat dilihat pada lampiran Microsoft Project. Fluktual
biayaltotal proyek ditampilkan pada Tabel 5.9.
Tabel 5.9. Perubahan Biaya Total Proyek (Total Cost)
Nd | Selisih Ne Kenaikan
No Tahap | N | .
(Hari) | (Hari) (Rupiah) {Rupiah)
1 Kondisi Normal 95.00 11,925,879,167.68
2 | Percepatan Tahap 1 | 93.58 | 1.42 | 1.015 | 11,747,618,658.02 | 178,260,509.66
3 | Percepatan Tahap2 | 92.77 | 223 | 1.024 | 11,645934,846.17 | 101,683,811.85
4 | Percepatan Tahap 3 | 92.38 | 2.62 | 1.028 | 11,596,975,973.79 | 48,958,872.38
5 | Percepatan Tahap 4 | 92.09 | 2.91 1.032 | 11,560,570,658.44 36,405,315.35
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Darj Tabel 5.9. terlihat bahwa percepatan pada tahap 1 sampai tahap 4
mengalami kenaikan biaya proyek yang cukup besar karena dengan penambahan
biaya lembur akan memaksimalkan tenaga kerja sehingga biaya yang dikeluarkan
lebih banyak.

Percepatan juga mengakibatkan kenaikan alokasi penggunaan biaya
tidak langsung yang seiring dengan betkurangnya durasi pekerjaan. Kenaikan
biaya tidak langsung di tampilkan dalam Tabel. 5.9,

Tabel 5.10. Perubahan Biaya Tidak Langsung (Indirect Cost)

No Tahap (%)

Nd | Selisih Ne Kenaikan

(Hari) | (Hari)

(Rupiah)

(Rupiah)

1 | Kondisi Normal 95.00

804,996,843.82

2 | Percepatan Tahap 1 [ 93.58 [ 1.42 |[1.015 | 792,964,259.42 12,032,584.40
3 |Percepatan Tahap2 | 92.77 (2.23 |1.024 | 786,100,602.12 6,863,65730 |
4 | Percepatan Tahap 3 | 92.38 |2.62 | 1.028 | 782,795.878.23 3,304,723.89
5 |Percepatantahap4 |92.09 |2.91 |[1.,032 | 780,338,519.44 2,457,358.79

Sumber : Hasil Perhitungan 2014.

Besarnya biaya tidak langsung pada proyek perhari adalah Rp.
8,473,650.99 yang di dapat dari Gambar. 5.9 sebesar 6.75 % dari biaya total
proyek yang dibbagi normal durasi awal proyek. Pada percepatan tahap 1 sampi
tahap 4 didapat total biaya tidak langsung sebesar Rp. 19,080,073.29. Besarnya
biaya langsung yang dikeluarkan proyek dapat diketahui dengan mengurangkan

1‘\;0!10 trtal savnvralsr Ancicemes Wlmeon Ve e o a0 1.1 1 1.
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Tabel 5.11. Perubahan Biaya Langsung (Direct Cost)

No Tahap D B. Total B. T. Langsung B. Langsung
(hari) (Rupiah) (Rupiah) (Rupiah)
|| KondisiNommal 19500 | 11 955 879.167.68 | 804,996,843.82 | 11,120,882,323.86
2 || Percepatan tahap 1" | 93.58 | 11 747 618 658.02 | 792,964,259.42 10,954,654,398.60
3 || Percepatan tahap 2 | 92.77 11,645,934,846.i7 786,100,602.12 | 10,859,834,244.05
4 | | Percepatan tahap3 | 92.38 | 11 596 975 97379 | 782,795.878.23 10,814,180,095.56
> | | Percepatan tahap 4 | 92.09 | 11 560 570,658.44 | 780,338.519.44 10,780,232,138.99

Spmber : Hasil Perhitungan 2014.

Tabel 5.12 Rekapitulasi Biaya dan Waktu Optimum dari Setiap Kompresi

Biaya Setelah Kompresi
Durasi | Perubahan Perubahan
[J , Biaya Tidak
o.| Kondist |Proyek| Dumasi Biaya Total Biaya Langsung Lang Biaya
+ s‘m‘g
(Hari) | (Har) (Rupiah) (Rupiah) ] (Rupizh)
(Rupinh)
| | Normal 95 11,925,879,167.68 | 11,120,882,323.86 | 804,996,843.82
F Lembur 1 jam | 93.58 142 | 11,747,618,658.02 | 10,954,654.398.60 | 792,964.259.42 14,311,904.74
3 | Lembur2 jam | 92.77 223 111,645,934,846.17 | 10,859,834.244.05 | 786,100,602.12 | 21,054.985.68
4 | Lembur 3 jam | 92.38 262 [11,596.975.973.79 | 10,814,180,005.56 | 782,795,878.23 | 26450,005.05
5 ( Lemburd jam | 92.09 291 |11,560,570,658.44 | 10,780,232,138.99 | 780,338,519.44 | 29,998,856,31

Sumber : Hasil Perhitungan 2014.
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Tabel 5.12 menunjukkan pada lembur satu jam sampai empat jam semakin
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hubungan waktu dan biaya pelaksanaan proyek yang dapat dilihat pada Gambar
5.10, serta hubungan biaya total, biaya langsung dan biaya tidak langsung pada
Gambar. 5.11.

Rp11,300,000,000.00
96.00
p11,100,000,000.00 -+
= "“,& - 9q00 — Blaya.
. )
£10,900,000,000.00 = ::“', —=4-~Durasi Proyek
et '0----*_- 92,00
Rp10,700,000,000.00
Rp10,500,000,000.00 90.00
lembur4 lambur 3Lembur2lembur1 Normal
jam jam jam jam
Kandisl

Gambar 5.10 Grafik hubungan waktu dan biaya-

Diantara keempat penambahan jam kerja (lembur), biaya yang paling

mmal adalah biaya pada saat kondisi tanpa kompresi atau kondisi normal
d ngan biaya sebesar Rp. 11,925,879,168. Sedangkan waktu palmg minimal
dapat pada penambahan empat jam kerja lembur, pada kondisi ini terjadi
pengurangan waktu proyek sebesar 2.91 hari dari 95 menjadi 92.09 hari akan
tetapi scbagai konsekuensinya maka terjadi penambahan biaya sebesar Rp.
110,144,141 dari biaya total normal sebesar Rp. 11,925,879,168 menjadi sebesar
p Rp. 12,036,023,308. Selain itu penambahan biaya akibat kompresi pada
emua kondisi lebih kecil dibandingkan dengan biaya denda apabila terjadi
keterlambatan hal ini berarti melakukan kompresi dengan menambah i jam kerja
apat memberikan keuntungan bagi pelaksana proyek. Keuntungan terbesar
[iidapatkan pada penambahan 2 jam kerja, pada kondisi ini penambahan biaya
sebesar Rp 21,054,985.68 dengan biaya denda sebesar Rp 35 ,»177,637.50 se}ungga
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Tabel 5.13. Perbandingan Penambahan Biaya dengan Biaya Denda
pn
Durasi | Perubaha _ Pernbahan | Keter- _
- . Biaya Total ) BiayaDenda | Keuntungan
No| [Kondis |proyek | ndurad (Rupiah) biaya lambatan (Rupiat) )
ia pl )
(harl) | (lard) (Rapizk) | (uari (opih
1 Normal 95 11,025,879,167.68
4 Imlbms jam 9238 2_62 11,596,975,973.79 26,450,005.05 3 35,777,637.50 9.32?,632-4‘6
5 |Lembur4jam | 9209 | 201 11,560,570,658.44 20,008,856.31 3 35,777,637.50 | 5,778,781.20




